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Rechtliche Informationen

Wichtige Informationen

Texas Instruments ibernimmt fiir die Programme oder das Handbuchmaterial keinerlei
Garantie, weder direkt noch indirekt. Dies umfasst auch jegliche indirekte
Gewabhrleistung hinsichtlich der Marktgangigkeit oder der Eignung flr einen
bestimmten Zweck, ist jedoch nicht hierauf beschrankt und dieses Produkt wird
lediglich ,,So wie es ist” zur Verfligung gestellt

In keinem Fall kann Texas Instruments fiir Schaden haftbar gemacht werden, die sich
entweder in Verbindung mit dem Kauf bzw. Gebrauch dieses Produkts ergeben oder
dadurch verursacht werden, dies gilt fiir spezielle, begleitende und versehentliche
Schaden sowie fiir Folgeschdden. Texas Instruments haftet maximal und ausschlieBlich
in der Hohe des Kaufpreises des Produkts, unabhangig vom jeweiligen Fall. Weiterhin
haftet Texas Instruments nicht fir Forderungen einer anderen Partei, die sich aus dem
Gebrauch dieses Produkts ergeben, welcher Art diese Forderungen auch immer sein
maogen.

Diese wissenschaftliche Produkt-Applikation (APP) ist lizenziert. Siehe Bedingungen der
Lizenzvereinbarung.
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Anmelden mit lhrem Tl-Konto

Um die TI-SmartView™ Emulator-Software fiir MathPrint™ Taschenrechner verwenden
zu kénnen, missen Sie sich an Ihrem Tl Konto anmelden.

1. Starten Sie die TI-SmartView™ Emulator-Software fiir MathPrint™ Taschenrechner.

Wenn Sie die Software zum ersten Mal starten, werden Sie aufgefordert, die Lizenz,
die Datenschutzrichtlinie und die Online-Nutzungsbedingungen zu akzeptieren.

= x

W TEXAS INSTRUMENTS

By using the application, you indicate your agreement with the
terms and conditions of the License, TI's Privacy Policy, and Tl's
Online Terms of Use.

DECLINE  ACCEPT

Klicken Sie auf Accept.

2. Klicken Sie in der Anmeldeaufforderung auf LAUNCH SIGN IN.

= x

Please sign in to your account to continue.

"]

PURCHASE LICENSE LAUNCH SIGN IN

Hinweis: Wenn Sie eine Einzelbenutzerlizenz erwerben moéchten, klicken Sie auf
PURCHASE LICENSE.

Dadurch wird die Anmeldeseite von Texas Instruments in lhrem Browser geodffnet.
SchlieRen Sie den Anmeldevorgang mit einem Google-Konto oder mit der mit Ihrem
TI-Konto verbundenen E-Mail-Adresse ab.

x
Please sign in to continue

i3 TEXAS INSTRUMENTS

SIGN IN

© scmmmicooa

Or sign in with email

‘ 1 Email (user name) ¢
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Nach der Validierung Ihres Kontos wird eine Erfolgsmeldung im Browser angezeigt
und die Software wird gedffnet.

Lizenzinformationen anzeigen
Wenn Sie angemeldet sind, kdnnen Sie die Details lhrer Lizenz einsehen.

P Gehen Sie zu Help > License Info.

= x
Account Info
email@domain.com

Subscription Expiration
2026-12-30

Session Expiration
6 Days 23 Hours 56 Minutes

Account Info: E-Mail-Adresse des aktuellen Benutzers.

Subscription Expiration: Ablaufdatum der aktuellen Software-Lizenz.
Session Expiration: Verbleibende Zeit in der aktuellen Sitzung.

Wahrend die Software benutzt wird, stellt sie alle 15 Minuten eine Verbindung mit
dem Lizenzierungssystem her. Wenn der Benutzer zu irgendeinem Zeitpunkt offline
geht, lduft die Software noch sieben Tage lang ab dem Zeitpunkt der letzten
Verbindung.

Abmelden von lhrem Konto
1. Gehen Sie zu Help > Sign Out.
2. Klicken Sie auf SIGN OUT.

Die Software wird geschlossen und eine Browser-Registerkarte 6ffnet die
Anmeldeseite.

Bei der Abmeldung wird der aktuelle Status gespeichert und die Lizenz wieder in
den Pool der verfligbaren Platze zurlickgegeben. Wenn die Software tber File > Exit

oder die Schaltflache ,,SchlieBen” geschlossen wird, wird der Benutzer nicht
automatisch abgemeldet und die Lizenz freigegeben.

Anmelden mit lhrem TI-Konto 2



Einflihrung in die TI-SmartView™ Emulator-Software fiir
MathPrint™ Taschenrechner

Die TI-SmartView™ Emulator-Software fiir MathPrint™ Taschenrechner ermoglicht die
Darstellung eines wissenschaftlichen Taschenrechners von Tl fiir alle Schiler im
Klassenzimmer.

Arbeitsbereich Taschenrechner-Emulator

fiir folgende Tatigkeiten:

e Emulator auswahlen
% — Wahlen Sie einen Emulator aus, mit dem Sie arbeiten mochten.
— TI-30X Plus MathPrint™
— TI-30X Pro MathPrint™
—  TI-30XS MultiView - TI-30XB MultiView™
—  TI-34 MultiView™
e GroRe Emulatoransicht ausblenden/anzeigen

£

— Sie konnen die ganze Emulatoransicht mit oder ohne
Fensterbereich fur die vergroRerte Darstellung anzeigen.

e Tastenfolge ausblenden/anzeigen

— Zeigt die gedriickten Tasten, damit die Schiler sie nachvollziehen
kénnen.

o Offnen eines separaten Screenshot-Fensters

— Erfassen und speichern Sie Emulator-Screenshots als
Computerdateien, ahnlich wie mit TI Connect™ CE Screen Capture.

o]l

Siehe: Verwenden des Arbeitsbereichs des Taschenrechner-Emulators zur Verbesserung
Ihrer Klassenzimmer-Prasentationen.
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Erster Start: Auswahl des Emulatortyps

Beim ersten Start von TI-SmartView™ fir MathPrint™ auf Ihrem Computer wird ein
Benachrichtigungs-Dialogfeld angezeigt.

{3 Available Emulators % Wahlen Sie lhren Emulatortyp tber das
Pulldown-Meni und wahlen Sie dann OK.
B Der gewdhlte Emulator wird fiir die erste

Prasentation angezeigt.

Ti-30X Plus MathPrint
TI-30X Pro MathPrint re using the
TI-30XS Multiview ar.

Ti-34 MultiView

TI-SmartView™ fur MathPrint™ wird bei einem erneuten Start des Programms immer in
dem Zustand ausgefiihrt, in dem es sich beim letzten Beenden befunden hat. Nach dem
Start der Software kénnen Sie den Standard-Emulator dndern.

Siehe: Auswahlen eines Emulatortyps

Der zuletzt angezeigte Emulatortyp wird zum Standard-Emulator und die
FenstergrofRe wird so angezeigt, wie Sie sie zuletzt eingestellt hatten.

Siehe: Andern der GréRe des Fensterbereich fiir die vergréRerte Darstellung des TI-
SmartView™ Emulators

Einfiihrung in die TI-SmartView™ Emulator-Software fiir MathPrint™ Taschenrechner 4



Verwenden des TI-SmartView™ Emulator-
Arbeitsbereichs fiir MathPrint™ Taschenrechner

Der TI-SmartView™ Emulator-Arbeitsbereich fiir den MathPrint™ Taschenrechner
enthalt Werkzeuge, die Sie zur Eingabe von Berechnungen verwenden kdnnen.

Brusrenans  TIF30X Pro DEG

MathPrint

Key Press History
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Teile des TI-SmartView™ Emulator-Arbeitsbereichs

o

File Edit View Actions Help

Meniileiste - Uber diese Meniis fiihren Sie alle Funktionen des Emulators aus,
einschlieflich:

* File (Datei — beenden oder
abbrechen

e Edit (Bearbeiten) —z. B.
Tasten als Text in einer
speziellen Schriftart
kopieren

e View (Ansicht) — Andern der
Ansicht

e Actions (Aktionen) — z. B. Screenshot

e Help (Hilfe) — Hilfe und Links

Hinweis: Die meisten Aktionen in diesen Mens kdnnen Sie durch Anklicken von
Symbolen in der Symbolleiste abschlieBen.

Symbolleiste — Mit den Symbolen in der Symbolleiste kdnnen Sie folgende
Tatigkeiten durchfiihren:

e Auswahlen eines anderen Taschenrechnermodells

e Umschalten zwischen vergroBerter Darstellung und Ein-/Ausschalten der
Chronik der Tasteneingaben

e Erfassen des aktuellen Emulator-Bildschirms

Festlegen der Position von Emulator und Symbolleiste

¥
¢ Emulatorposition links/rechts E—I — Umschalten zwischen Anzeige des
Taschenrechner-Displays links/rechts auf dem Bildschirm. Dies ist praktisch

bei der Prasentation auf einem interaktiven Whiteboard.

e Symbolleiste oben/unten EI — Umschalten zwischen Anzeige der
Symbolleiste oben oder unten auf dem Bildschirm. Dies ist praktisch bei der

Prasentation auf einem interaktiven Whiteboard.
Hinweis: Besonders bei der Arbeit mit einem interaktiven Whiteboard kénnen
Sie die Anordnung der Elemente fiir eine moglichst leichte Bedienung
optimieren.

Emulator-Fensterbereich — In diesem Fensterbereich kdnnen Sie entweder den
vollstandigen Emulator oder nur die Tastaturansicht anzeigen.

Fensterbereich fiir die vergroBerte Darstellung/Fensterbereich fiir die Chronik der
Tasteneingaben — In diesem Fensterbereich kénnen Sie eine vergroerte
Darstellung des Taschenrechner-Bildschirms und/oder eine Chronik der
Tasteneingaben anzeigen.

Verwenden des TI-SmartView™ Emulator-Arbeitsbereichs fiir MathPrint™ Taschenrechner
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Die folgenden Anzeige-Optionen stehen lhnen zur Verfliigung:

e NurvergroRerte Darstellung e Nur Chronik der Tasteneingaben
e VergroRerte Darstellung + e Bildschirm fur die vergroRerte
Chronik der Tasteneingaben Darstellung ausblenden

@ GroRe der Fensterbereiche dndern — Klicken Sie auf eine vertikale Kante eines
Fensterbereichs und ziehen Sie, um dessen GroRe zu dndern.

Verwenden der TI-SmartView™ Emulatortastatur

Anstelle die Tasten am Taschenrechner mit den Fingern zu driicken, verwenden Sie in
der Emulator-Software den Mauszeiger.

Klicken Sie mit der Maus auf die Taschenrechnertasten im TI-SmartView™ Emulator fiir
MathPrint™, wie Sie die Tasten am Taschenrechner driicken wiirden.

Halten Sie eine Pfeiltaste gedriickt, um kontinuierlich zu scrollen.

Wenn Sie den Cursor mit einer Pfeiltaste bewegen und die Taste gedriickt halten, wird
kontinuierlich gescrollt, sodass Sie die Taste nicht mehrmals driicken miissen. Im
Tastenfolgenfenster ist das Symbol fiir eine solche Pfeiltaste mit einem Uhrsymbol
gekennzeichnet.

Wenn Sie eine Pfeiltaste mehrmals hintereinander driicken, wird ein Pfeil mit einem
Zahler angezeigt.

Wenn Sie eine Pfeiltaste mehrmals hintereinander driicken, wird in der Chronik der

Tasteneingaben eine Pfeiltaste angezeigt; an dieser Pfeiltaste DO befindet sich eine
Zahl, die angibt, wie oft die Pfeiltaste gedriickt wurde.

Ziehen und Ablegen eines Bildschirms in einer anderen Anwendung

Sie kénnen einen Bildschirm aus dem TI-SmartView™ Emulator fiir MathPrint™
Taschenrechner auf eine andere Anwendung ziehen, um ihn dort einzufiigen.

Zu den Bildschirmen des TI-SmartView™ Emulators flir MathPrint™ Taschenrechner, die
Sie verschieben und einfligen kénnen, gehoren:

e Der Bildschirm liber der Tastatur im Emulator-Fensterbereich
e Die vergroRerte Darstellung

e Gespeicherte und nicht gespeicherte Screenshots im Arbeitsbereich ,Screen
Capture” (Schnappschuss)
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Zuriicksetzen des Emulators
So setzen Sie den Emulator zuriick:
1. Klicken Sie auf Actions (Aktionen).

2. Klicken Sie auf Reset Emulator (Emulator zuriicksetzen).

3. Klicken Sie auf Reset (Zurlicksetzen).

& :

Reset Emulator?

Resetting the emulator will overwrite all the

contents of the current emulator state.

Do you want to reset the emulator?

CANCEL RESET

.

Zurlicksetzen des Emulators:

e Uberschreibt den aktuellen Emulatorstatus

e Loscht die Chronik der Tasteneingaben

Verwenden des TI-SmartView™ Emulator-Arbeitsbereichs fiir MathPrint™ Taschenrechner 8



Speichern und Laden eines MathPrint™ Emulators Status

Wenn Sie den Status des MathPrint™ Emulators speichern.,.wird eine Datei erstellt, in
der die Emulatoreinstellungen mit allen vorgenommenen Anderungen enthalten sind.

Angenommen, Sie richten fir eine Klasse eine Prasentation ein, bei der Sie Daten in
einen Dateneditor und Funktionen in f(x) und g(x) eingeben. Wenn Sie diese
Anderungen in einer Emulatorstatusdatei speichern, kénnen Sie die Datei fiir die
Prasentation spater jederzeit wieder laden. Wenn Sie verschiedene Prasentationen fir
unterschiedliche Klassen vorbereiten wollen, erstellen Sie einfach mehrere
Emulatorstatusdateien.

Hinweis: Die Chronik der Tasteneingaben, Bildschirmabbildungen, die Emulatoransicht
und die EmulatorgrofRe werden nicht in der Emulatorstatusdatei abgelegt. Bitte
beachten Sie, dass die MathPrint™ Emulatorstatusdatei relativ groR sein kann. Wenden
Sie sich bei Problemen mit lhrer Speicherkapazitat bitte an Ihre IT-Abteilung.

Speichern des MathPrint™ Emulatorstatus

Das Verwalten, Speichern und Laden eines Emulatorstatus ist fir jeden MathPrint™
Emulator moglich. Die Emulatorstatusdatei fir TI-30X Plus MathPrint™ kann nur im TI-
30X Plus MathPrint™ Emulator geladen werden.

Hinweis: Der TI-30X Pro MathPrint™ Emulatorstatus kann nur im TI-30X Plus
MathPrint™ Emulator geladen werden.

1. Klicken Sie auf Actions > Save Emulator State... (Aktionen > Emulatorstatus
speichern...).

"B T1-Smartview™ for MathPrint™ calculators

File Edit View Actions Help

Capture Screen

B =am

Save Emulator State...

prosvsumers T

= Load Emulator State.

Res

ulator

(i [t | o ||

GO0
EAEARNEE

2. Im Dialogfeld:
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a) Navigieren Sie zu dem Ordner, in dem die MathPrint™ Emulatorstatusdatei
gespeichert werden soll.

b) Geben Sie einen Dateinamen ein. Verwenden Sie einen Namen, der den
MathPrint™ Emulatorstatus beschreibt.

Hinweis: Die MathPrint™ Emulatorstatusdateien besitzen einen
vorkonfigurierten Dateinamen mit der Erweiterung *.s3l, die angibt, dass es
sich hierbei um einen von der TI-SmartView™ MathPrint™ Emulator-Software
erstellten TI-30X Plus MathPrint™ Taschenrechner-Emulatorstatus handelt. Die
Erweiterung fiir den TI-30X Pro MathPrint™ Taschenrechner-Emulatorstatus ist
*.s3r.

c) Klicken Sie auf Save (Speichern).

Laden eines MathPrint™ Emulatorstatus

Da die MathPrint™ Emulatorstatusdateien modellspezifisch sind, konnen Sie nur
Emulatorstatusdateien fiir das gerade aktive Rechnermodell laden.

1. Klicken Sie auf Actions > Load Emulator State (Aktionen > Emulatorstatus laden).

TE TI-SmartView™ for MathPrint™ calculators

File Edit View Actions Help

B =2 Capture Screen

Save Emulator State.
o T DEG

= Load Emulator State...

Reset Emulator

e ]e)[-]
e o 3 F il

Calls][e][+]

b B

2. Im Dialogfeld:

a) Navigieren Sie zu dem Ordner, in dem die Emulatorstatusdatei gespeichert ist.

Hinweis: Es werden nur die MathPrint™ Emulatorstatusdateien fir das aktive
Rechnermodell angezeigt.

b) Klicken Sie auf den Namen des MathPrint™ Emulatorstatus, um ihn zu
markieren.

c) Klicken Sie auf Offnen.

Verwenden des TI-SmartView™ Emulator-Arbeitsbereichs fiir MathPrint™ Taschenrechner 10



Auswdbhlen einer Anzeigeoption

Sie kénnen optionale Fensterbereiche anzeigen bzw. ausblenden und festlegen, welche
Informationen darin angezeigt werden sollen. StandardméRig zeigt die TI-SmartView™
Emulator-Software fiir MathPrint™ Taschenrechner den Arbeitsbereich des
Taschenrechner-Emulators in der vergroRRerten Darstellung an.

Anzeige des Taschenrechner-Bildschirms

1. Klicken Sie auf , 2. Klicken Sie erneut auf
um die vergroBerte Darstellung
Darstellung anzuzeigen.
auszublenden.

, um die vergroRerte

Fle  Edit

EE

Auswadhlen eines Emulatortyps

Klicken Sie bei auf den Abwartspfeil, um einen Emulatortyp auszuwdhlen.

TI-30X Plus MathPrint

o TI-30X Pro MathPrint ‘
TI-30XS MultiView

Tl-34 MultiView

Fir jeden Emulatortyp wird das zugehorige Taschenrechnermodell angezeigt.
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Andern des Taschenrechner-Frontcovers
So dndern Sie das Frontcover:

1. Klicken Sie auf View (Anzeigen).
2. Bewegen Sie die Maus auf Calculator Faceplate (Taschenrechner-Frontcover).

3. Klicken Sie auf den Namen des Taschenrechner-Frontcovers.
Hell Dunkel Umriss

TI-30X Pro & rxs msmowents T1-30X Pro B s wsmowenrs T1-30X Pro

X3 Texas INSTRUMENTS
MathPrint MathPrint MathPrint

DEG DEG

insert quit insert quit insert

mode | |delete

matrix  stat-eg/distr | /,‘ mamx mrrvu't\m « -

ector  random  expr-eval

r\(r
IE]

quit

o[-

At matrix  statregidstr

math

[80dx  vector random expr-eval random  expi

£ I A )

1S | table | | clear

complex num-solv poly-solv  sys-solv. poly-so & complex num-solv poly-solv  sys-solv %
cos cos
cos™! cos”!
constants  op setop setop
x
convert  basen <0
E F o
B c fard
reset answer e ans off reset s answer
-nllmm B [ ]C0 ][ ][] [eme]

Anzeigen und Ausblenden der Chronik der Tasteneingaben

Klicken Sie auf , um die Chronik der Tasteneingaben ein- bzw. auszublenden.
Klicken Sie auf CLEAR (LOSCHEN) im Fensterbereich neben der Chronik der

Tasteneingaben, um den Verlauf zu I16schen.

o (233
; E i 14(1 F
[1] Klicken Sie hier [0} Klicken Sie @ Klicken Sie hier,
und ziehen Sie die hier, um die
Maus, um die nachdem Sie Chronik der
GrolRe des die Tasten Tasteneingaben zu

|6schen.

Verwenden des TI-SmartView™ Emulator-Arbeitsbereichs fiir MathPrint™ Taschenrechner 12



Fensterbereichs zu zum Kopieren

andern, in dem die der Schriftart
Chronik der als Grafik
Tasteneingaben ausgewahlt
angezeigt wird. haben.

Wenn Sie ,,Clear” (Loschen) driicken, wird das folgende Informationsfeld angezeigt:

rEEJ Key Press History [ﬁr

Are you sure you want to clear the history?

CANCEL CLEAR

Kopieren der Chronik der Tasteneingaben in eine andere
Anwendung

b

Sie kénnen den Inhalt der Chronik der Tasteneingaben ganz oder teilweise in eine

andere Anwendung wie ein Textverarbeitungsprogramm kopieren. Dabei konnen die
B

grafischen Tastendarstellungen , die in der Chronik der Tasteneingaben angezeigt
werden, oder die Tastenanschlige als Textzeichen (5] (=] (6] kopiert werden.

Hinweis: Wenn Sie Tasten als Textzeichen kopieren, wird fiir die Zeichen die Schriftart
TI-30X Pro Key verwendet. Sie kdnnen Schriftarten fiir primdre Tastenfunktionen
einflgen. Schriftarten sekundarer Tastenfunktionen lassen sich nicht iber die Funktion
,Copy As Font” (Als Textzeichen kopieren) in TI-SmartView™ einfiigen. Die 2nd-
Funktionen kdnnen mit der installierten Schriftart manuell eingefligt werden. Diese
Schriftart wird bei der Installation der TI- SmartView™ Software fiir MathPrint™
Taschenrechner automatisch auf dem Computer installiert. Die Schriftart umfasst alle
Tasten-Schriftarten des TI-30X Plus als Untergruppe der TI-30X Pro Tasten-Schriftarten.

Kopieren von Tasten als Grafik oder Textzeichen

1. Markieren Sie die Taste(n), die kopiert werden sollen.
Wabhlen Sie eine der folgenden Methoden, um Tasten im Fensterbereich , Key Press
History” (Chronik der Tasteneingaben) auszuwahlen:

Taste Methode
— Eine einzelne Taste: Klicken Sie auf eine Taste.
— Mehrere Tasten: Klicken Sie auf eine Taste.
Halten Sie auf lhrer Computertastatur
Strg gedruickt.
Klicken Sie auf andere Tasten, um

13 Verwenden des TI-SmartView™ Emulator-Arbeitsbereichs fiir MathPrint™ Taschenrechner



Taste Methode
mehrere Tasten auszuwahlen.

— Mebhrere aufeinander folgende Klicken Sie auf eine Taste.

Tasten: Halten Sie auf lhrer Computertastatur
die Umschalttaste gedriickt.
Driicken Sie eine andere Taste.
Hinweis: Hierdurch wahlen Sie diese
beiden Tasten sowie alle Tasten
zwischen den beiden Tasten aus.

— Alle Tasten: Klicken Sie auf eine Taste.
Flhren Sie einen Rechtsklick aus.
Klicken Sie auf Select All (Alles
auswahlen).

Hinweis: Die nachstehende Grafik zeigt, wie eine Taste aussieht, bevor und
nachdem Sie sie ausgewahlt haben.

Vorher: Nachher:

B B

(2] 2]

2. Tasten auswahlen

3. Klicken Sie auf Edit>Copy (Bearbeiten>Kopieren), um die Tasten als Grafik zu
kopieren
oder
Klicken Sie auf Edit>Copy As Font (Bearbeiten>Als Textzeichen kopieren), um Tasten
als primare Textzeichen ((5] [=] [6]) zu kopieren.

4. Wechseln Sie zu einer anderen Anwendung.

5. Flgen Sie die Tasten an der gew(inschten Stelle ein.

Hinweis:

Sie kdnnen die ausgewdhlten Tasten auch als Grafik in die andere Anwendung
ziehen.

Nachdem Sie die Tasten als Grafik in eine andere Anwendung kopiert oder gezogen
haben, kdnnen Sie dort ihre GroRe dndern.

In manchen Anwendungen werden die eingefligten Zeichen moglicherweise in der
Schriftart angezeigt, die an der jeweiligen Stelle gilt. In diesem Fall sind sie
moglicherweise nicht als Tasten des wissenschaftlichen Taschenrechners zu
erkennen. Formatieren Sie die Zeichen bei Bedarf dann mit der Schriftart TI-30X Pro

Verwenden des TI-SmartView™ Emulator-Arbeitsbereichs fiir MathPrint™ Taschenrechner 14



Key. Ndhere Informationen zum Formatieren der Zeichen finden Sie in der
Hilfedatei der jeweiligen Zielanwendung.
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Andern der Gréfle des Fensterbereich fiir die vergréfierte
Darstellung des TI-SmartView™ Emulators

Klicken Sie auf eine Kante des Fensterbereichs fiir die vergroRerte Darstellung und
verschieben Sie sie, um die GroRe des Fensterbereichs zu dndern.

B TI-Smartview™ for MathPrint™ calculators

File Edit View Actions Help

v s @

s TIF30XPro DEG

MathPrint

A’ [

Key Press History I

recall fard

fone (1123 (o)

off

Hinweis: Die Moglichkeit zur GroRBeneinstellung bezieht sich bei all diesen

Fensterbereichen auf deren Breite, ausgenommen die Chronik der Tasteneingaben, bei

der die Hohe gedndert wird.

Position des Emulators und der Symbolleiste

=g Emulatorposition links/rechts — Umschalten zwischen Anzeige des
Taschenrechner-Displays links/rechts auf dem Bildschirm. Dies ist
praktisch bei der Prasentation auf einem interaktiven Whiteboard.

= Symbolleiste oben/unten — Umschalten zwischen Anzeige der
Symbolleiste oben oder unten auf dem Bildschirm. Dies ist praktisch bei
der Prasentation auf einem interaktiven Whiteboard.

Verwenden des TI-SmartView™ Emulator-Arbeitsbereichs fiir MathPrint™ Taschenrechner
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Immer im Vordergrund

Waihlen Sie diese Option im Meni ,,View” (Ansicht), um das Fenster des TI-SmartView™
Emulators fir MathPrint™ Taschenrechner immer vor anderen geoffneten
Softwarefenstern anzuzeigen. Dies entspricht einem Taschenrechner, der auf Ihrem
Schreibtisch immer auf Ihren Papieren liegt. Verschieben Sie das Fenster auf lhrem
Computerbildschirm so, dass die Anzeige anderer Fenster durch die Option ,, Always in
Front” (Immer im Vordergrund) moglichst wenig gestort wird.

Um die Option ,Always in Front” (Immer im Vordergrund) auszuschalten, wahlen Sie
den Menupunkt im Meni ,,Ansicht” ab. Fir diese Funktion gibt es auRer dem Hakchen
im MenU bei aktivierter Funktion kein Symbol in der Symbolleiste und keine weitere
Anzeige.

Hinweise:

Die Fenster flr Arbeitsbereich und Schnappschuss des TI-SmartView™ Emulators fir
MathPrint™ Taschenrechner werden beide immer im Vordergrund angezeigt und je
nach Position umgeschaltet.

»Always in Front” (Immer im Vordergrund) sollte nicht in der Vollbild-Ansicht
verwendet werden, da sonst alle anderen Fenster von der Vollbildansicht des TI-
SmartView™ Emulators fiir MathPrint™ Taschenrechner verdeckt werden.
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Verwenden von Bildschirmaufnahmen

Mit dem Screenshot-Tool des TI-SmartView™ Emulators fir MathPrint™
Taschenrechner kénnen Sie den aktuellen Bildschirm des wissenschaftlichen
Taschenrechners erfassen.

So verwenden Sie die Screenshot-Funktion:

P Klicken Sie in der Symbolleiste auf..

Das folgende Fenster wird angezeigt:

"B TI-Smartview Sc _|a] x|

File Edit View Actions

(O]
1

*Capture 1 @

5
2,(2%+1) 35
[8+[18 52
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Teile des Screenshot-Arbeitsbereichs

o Erfassen Klicken Sie hier, um den angezeigten Emulatorbildschirm zu

erfassen.

Aktionen > Screenshot

Hinweis: Jedem Bild wird automatisch bei der Erfassung ein

Rahmen hinzugefiigt. Sie konnen diesen jedoch entfernen,

indem Sie auf Ansicht > Screenshot-Rahmen ausblenden

klicken. (Bei mehreren vorhandenen Bildern wird in diesem

Fall der Rahmen von allen Bildern entfernt.)

Mit der Screenshot-Funktion kénnen Sie:

e bis zu 44 Bildschirme gleichzeitig erfassen, (um weitere
Bilder zu erfassen, |6schen Sie Bilder im Screenshot-
Fenster)

e Screenshots automatisch speichern, bis Sie das
Hauptfenster von TI-SmartView™ fiir MathPrint™
Taschenrechner schlieRen.

Beim SchlieRen der Screenshot-Funktion wird eine
Eingabeaufforderung angezeigt, in der Sie Ihre Screenshots
speichern kdnnen. Sie kdnnen wahrend einer Sitzung in Tl-
SmartView™ fiur MathPrint™ Taschenrechner eine neue
Screenshot-Sitzung starten.

Sichern Klicken Sie hier, um die ausgewahlten Screenshots zu
speichern.
Datei > Speichern unter

Copy Klicken Sie hier, um ausgewahlte Screenshots in die
Zwischenablage zu kopieren.
Bearbeiten > Kopieren

Loschen Klicken Sie hier, um die ausgewdhlten Screenshots zu
speichern.
Datei > Speichern unter

GroRe andern Verschieben Sie den Punkt auf der Leiste, um die GréRe der
Vorschau des aktuellen Screenshots zu dndern.

Ansicht > Screenshots skalieren

Hinweis: Bildschirme werden in der eingestellten GréRe
gespeichert.

® © O o

@ Umbenennen Sie kénnen einen Screenshot umbenennen, indem Sie den
Namen markieren und einen neuen Namen eingeben.

6 View Hier kdnnen Sie Screenshots anzeigen.

Ziehen und Ablegen eines Bildschirms in einer anderen Anwendung

Sie kénnen einen Bildschirm aus dem TI-SmartView™ Emulator fiir MathPrint™
Taschenrechner auf eine andere Anwendung ziehen, um ihn dort einzuftigen.
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Zu den Bildschirmen des TI-SmartView™ Emulators fiir MathPrint™ Taschenrechner, die
Sie verschieben und einfligen kénnen, gehoren:

e Der Bildschirm liber der Tastatur im Emulator-Fensterbereich
e Die vergroRerte Darstellung

e Gespeicherte und nicht gespeicherte Screenshots im Arbeitsbereich ,Screen
Capture” (Schnappschuss)
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Tastenkiirzel auf der Computertastatur

Anstatt Tasten auf der Tastatur-Abbildung des TI-SmartView™ Emulators zu driicken,
koénnen Sie auch eine Taste auf Ihrer Computertastatur driicken.

Verwenden der Computertastatur

Die nachstehende Tabelle listet auf, mit welcher Taste der Computertastatur die
entsprechende Emulator-Taste betatigt wird.

e TI-30X Pro MathPrint™ or TI-30X Plus MathPrint™ tastenkombinationen
e TI-30XS-30XB MultiView™ tastenkombinationen

e TI-34 MultiView™ tastenkombinationen
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TI-30X Pro MathPrint™ or TI-30X Plus MathPrint™

Beispiel: Um den Bildschirm ,,Mode” (Modus) im Emulator anzuzeigen, driicken Sie
entsprechend der nachstehenden Tabelle auf der Computertastatur die Taste [W].

quit

TI-30X Pro MathPrint™ tastenkombinationen:

TI-30X Plus MathPrint™ tastenkombinationen:

Znd (modie] delete 0] ®
[al [W] | [Delete] [<] [1~]
[In log (math] [data] ® ®
[R] [Tl vl (4 [—>1
(7107 [EE] ) [table] [clear]
[U] [ [P] [A] | [Backspace]
i) (5] 2 =) =
[D] [F] [G] [H] 11
=3 5 | 0]
[J] [K] [l [ [*1
(7] 7 B ] =]
[L] [71] [el [e1 [-1
5 [l H| 8]
[Z] [4] [5] [€] [+]
sto-] [ 2 3] oz
[X] [1] [2] [31 [c]
[on) [0] B (=) [enter]
vl [0] [.] [B] [Enter]
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*Hinweis:

Druicken Sie auf der MAC-Computertastatur

- [Delete] fir [delete].
- [Backspace] fiir [clear].
2nd [mode] [delete] 0] @
[Q] [W] | [Delete] [ <1 4
% ['1
[In log math | [data] ] :D
R T Y
[R] [T] [Y1] (41 [—]
@010 [Eg] B3 [table] clear
[V] [1 [P] [A] | [Backspace]
®

23 Tastenkiirzel auf der Computertastatur




TI-30XS/30XB MultiView™

Beispiel: Um den Bildschirm ,,Mode” (Modus) im Emulator anzuzeigen, driicken Sie
entsprechend der nachstehenden Tabelle auf der Computertastatur die Taste [W].

quit

TI-30X45 MultiView™ keyboard shortcuts:

2nd 0] @
[Ql] [W] [Delete] [<1 (T
or or or
[CEril+ | [Ctri]+[ < ]
[Delete] e+ T
@ ®
[R] [T] [Yl 1 [>]
or or
[Ctri]+] —= 1
ctril[ 1
(in]
[U] [11 [P] [A] | [Backspace]
or
[Ctri]+
[Backspace]
MacE:
[Clear]
[sin] [cos] (=]
[D] [F] [G] [H] [/1
X7 0]
[J1 [K] | [Shiftl+[(] [ [Shift]+[)] [Shift]+[*]
E]] (-]
[L] [7] (2] 91 [-1
(4) (5] (6]
[Z] [4] [51 [6] [Shift]+[ +]
sto* [ 2] 3]
[X] [11 [2] [31] [C]
@ O =)
vl [o] [-1 [B] [Enter]
or
[Ctri]+[Enter]
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*Hinweis:

Druicken Sie auf der MAC-Computertastatur

- [Delete] fir [delete].
- [Backspace] fiir [clear].
2nd [mode] [delete] 0] @
[Q] [W] | [Delete] [ <1 4
% ['1
[In log math | [data] ] :D
R T Y
[R] [T] [Y1] (41 [—]
@010 [Eg] B3 [table] clear
[V] [1 [P] [A] | [Backspace]
®
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TI-34 MultiView™

Beispiel: Um den Bildschirm ,,Mode” (Modus) im Emulator anzuzeigen, driicken Sie
entsprechend der nachstehenden Tabelle auf der Computertastatur die Taste [W].

quit

TI-34 MultiView™ keyboard shortcuts:

2nd ® ®

[al W] [Delete] [«1 p
or or [ 01

[Ctril+ | [Ctri]+[ <~ ] )
[Delete] et T
@ ®
[R] [T] [Y1] (1 [=>1]
or
G N
[ctrilf ]

raimp]
[ul [ [P] [A] | [Backspace]
or
[Ctril+
[Backspace]
MacE:
[Clear]

=]
[D1] [F] [G] [H] [/1
0]
[J1 [K]1 | [Shif]+[(] | [Shift]+[}] [Shift]+[*]
£l =
L1 [71 [8] [91 [-1
(6]
[Z1] [4] [51 [&] [+1

al 2] [E]

[X1] [1] [2] [3] [cl

[on] El =) enter
vl [0] [.] [B] [Enter]
or
[Ctri]+[Enter]
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*Hinweis:

Druicken Sie auf der MAC-Computertastatur

- [Delete] fir [delete].
- [Backspace] fiir [clear].
2nd mode| [delete] @) =
[a@] [W] | [Delete] [ <] 4
* ['1
[In'leg math] [data] ] »
[R] [Tl [yl (41 [—1]
e [Ee] (58] [tabe] [clear]
[V] [1 [P] [A] | [Backspace]
®
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Allgemeine Informationen
Online-Hilfe

education.ti.com/eguide

Wahlen Sie Ihr Land aus, um weitere Produktinformationen zu erhalten.
Kontaktieren Sie den Tl Support

education.ti.com/ti-cares

Wabhlen Sie lhr Land aus, um auf technische und sonstige Support-Ressourcen
zuzugreifen.

Service- und Garantieinformationen

education.ti.com/warranty

Wahlen Sie fur Informationen zur Dauer und den Bedingungen der Garantie bzw. zum
Produktservice lhr Land aus.

Eingeschrankte Garantie. Diese Garantie hat keine Auswirkungen auf lhre gesetzlichen
Rechte.
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